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NEW QUESTION 1
You have a table that contains data relating to exam candidates and their associated scores.
You need to visualize the exam data by separating the data into quartiles. The visualization must display the mean score and must identify any outliers.
Which type of chart should you use?

A. line
B. histogram
C. pie
D. box and whisker

Answer: D

Explanation: 
https://support.office.com/en-us/article/create-a-box-and-whisker-chart-62f4219f-db4b-4754-aca8-4743f6190f0

NEW QUESTION 2
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, white others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a query named Query1 that retrieves the user information from two Excel files. One of the Excel files does not contain location information. A sample of
the data retrieved t]y the query is shown in the following table.

You need to ensure that values in UserName are unique. The solution must ensure that the locations are retained. A sample of desired output is shown in the
following table.

Solution: You select the-UserName and Location columns, and then you click Remove Duplicates. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 3
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded
to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Your company has 100 product subcategories and more than 10,000 products.
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End of repeated scenario.
You have a PivotChart that uses Manufacturer as the axis and the sum of SalesAmount as the values. You need to ensure that only the top 10 manufactures
appear in the chart.
What should you do?

A. Change the format of the SalesAmount field.
B. Create a calculated column.
C. Configure the Value Filters.
D. Summarize the SaleAmount field by Max.

Answer: C

Explanation: 
https://www.extendoffice.com/documents/excel/1963-excel-pivot-table-filter-top-10.html 

NEW QUESTION 4
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.
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Solution: You create a measure named Products the uses the CONCATENATEX DAX function. You add a PivotTable. You drag Products to the Rows field. You
drag Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 5
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions
will not appear in the review screen.
Your company has sales offices in several cities.
You create a table that the represents the amount of sales in each city by month as shown in the exhibit.

You need to ensure that alt values lower than 250 display a red icon. The solution must ensure that all values greater than 500 display a green icon.
Solution: You create a new conditional formatting rule that uses the Format only cells that contain rule type. Does this meet the goal?

A. Yes
B. No

Answer: A

NEW QUESTION 6
You install Microsoft Power BI Publisher for Excel.
You need to use Excel to connect and analyze Power BI data.
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To which two types of Power BI data can you connect? Each correct answer presents a complete solution. NOTE: Each correct selection is worth one point.

A. apps
B. datasets
C. reports
D. dashboard

Answer: BC

Explanation: 
Analyze in Excel is very useful for datasets and reports that connect to Analysis Services
Tabular or Multidimensional databases, or from Power BI Desktop files or Excel workbooks with data mo that have model measures created using Data Analysis
Expressions (DAX).
https://docs.microsoft.com/en-us/power-bi/service-analyze-in-excel

NEW QUESTION 7
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit. (Click the Exhibit button.)
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)

The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
Dates has a list of dates from 2015 to 2018

End of repeated scenario.
You create the column chart shown in the Pivot Chart exhibit. (Click the Exhibit button.)
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You need to ensure that the month axis is displayed chronologically. What should you do?

A. In the model, configure the Sort By Column setting for [Month] as [MonthID].
B. In the model, configure the Sort By Column setting for (Month) as [Date].
C. In PivotTable Fields, add [MonthID] to the Legend area.
D. In PivotTable Fields, add [Date] to the Legend area.

Answer: B

NEW QUESTION 8
You have a KPI named Goal that calculates the sales from the previous year and multiplies the sales by 1.1. You need to modify Goal to multiply the sales from
the previous year by 1.15.
What should you do?

A. From Power Pivot, modify the measure.
B. From the properties of the KPI, modify the KPI base field.
C. From Power Pivot, create a new calculated column, and then modify the KPI.
D. From the properties of the KPI, modify the absolute value.

Answer: A

NEW QUESTION 9
You have a pie chart.
You need the wedges of the pie chart to be separated as shown in the following exhibit.

A. Change the chart type to Pie of Pie.
B. Right-click the pie chart, click Expand/Collapse, and then click Expand.
C. Right-click the pie chart, click Expand/Collapse, and Then click Expand Entire Field
D. Select a wedge of the pie chart and then drag the wedge.

Answer: D

NEW QUESTION 10
You open C:\Data\Data,xlsx m Excel.
When you attempt to publish the file to Microsoft Power BI, you receive the following error message: "We couldn't publish to Power BI. Make sure your workbook is
saved as an Excel file (.xlsx or .xlsm) and is not password protected.*
You need to ensure that you can publish the file to Power BI. What should you do first?

A. Decrypt the workbook.
B. Disable iterative calculation for the workbook.
C. Copy the file to a network share.
D. Add a digital signature to the workbook.

Answer: A
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Explanation: 
With Excel 2016, you can publish your Excel workbooks right to your Power BI site, where you can create highly interactive reports and dashboards based on your
workbook’s data. You can then share your insights with others in your organization.
Before we go any further, there are few things to keep in mind:

 Before you can publish to Power BI, your workbook must be saved to OneDrive for Business.
 The account you use to sign in to Office, OneDrive for Business, and Power BI must be the same account.
 You cannot publish an empty workbook or a workbook that doesn’t have any Power BI supported content.
 You cannot publish encrypted or password protected workbooks, or workbooks with Information Protection Management.
 Publishing to Power BI requires modern authentication be enabled (default). If disabled, the Publish option is not available from the File menu.

https://docs.microsoft.com/en-us/power-bi/service-publish-from-excel

NEW QUESTION 10
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have the following data.

You need to retrieve a list of the unique ProductName entries.
Solution: Create a PivotTable that uses the ProductName field in the Rows area. Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 11
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it As a result, these questions will not appear in the review screen.
You have an Excel workbook that contains a table named Table1. A sample of the data in Table1 is shown in the following table.

You need to create a PivotTable in PowerPivot as shown in the exhibit.
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Solution: You create a hierarchy named Products that contains ProductCategory,
Solution: You create a measure named Products the uses the DataTable DAX Function. You add a PivotTable. You drag products to the Rows field. You drag
Price to the Values field.
Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 13
You have the following table.

You plan to use [Month Name] as the axis in a PivotChart.
You need to ensure that whenever [Month Name] is used in a chart, the months are displayed chronologically be default.
What should you do?

A. Sort the [Month Name] column by [Month Name].
B. Change the Data Type of [Month Name] to Date.
C. Sort the [Month Name] column by [Month Name].
D. Add a calculated column named [ID] that use the [Month Name] & [Month Number] DAX formula

Answer: D

Explanation: 
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References:
https://gasperkamensek.wordpress.com/2013/04/16/sorting-months-chronologically-and-not-alphabetically-in-a-

NEW QUESTION 15
Your network contains a folder that has data files m various formats.
You need to identify how many files of each extension type are in the folder by using Query Editor. What should you do?

A. Create a query that uses a file source, and then use the Count Values command on the Transform tab.
B. Create a query that uses a folder source, and then use the Group By command on the Home tab.
C. Create a query that uses a file source, and then use the Group By command on the Home tab.
D. Create a query that uses a folder source, and then use the Count Values command on the Transform tab.

Answer: B

NEW QUESTION 18
You have the following data sample.

You need to create a PivotTable that presents the data as shown in the following table.

A. Create a PivotTabl
B. Add UnitPrice to the Rows area and add SalesAmount to the Values area.Right-click a cell value for UnitPrice and modify the Group settings.
C. Create a PivotTabl
D. Add SalesAmount to the Rows area and add UnitPrice to the Values area.Right-click a cell value for SalesAmount and modify the Group settings.
E. Create a PivotTabl
F. Add UnitPrice to the Rows area and add SalesAmount to the Values area.Right-click a cell value for SalesAmount and modify the Field Settings.
G. Create a PivotTabl
H. Add SalesAmount to the Rows area and add UnitPrice to the Values area.Right-click a cell value for UnitPrice and modify the Field Settings.

Answer: A

NEW QUESTION 22
You open an Excel worksheet as shown in the following exhibit.

You need to export the data into a dataset in the Microsoft Power BI service. What should you do first?

A. Save the tile as an Excel template.
B. Select the data, and then insert a table.
C. Select the data, and Then insert a PivotTable.
D. Install Power BI Publisher for Excel.

Answer: D
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NEW QUESTION 27
You have a data model that has the following tables.

You create a PivotTable. The data displayed in the PivotTable is shown in the following table.

You need to ensure that the correct data is displayed. What should you do?

A. Modify the workbook connections
B. Configure the PivotTable Options
C. Modify the relationships
D. Refresh the data connection

Answer: C

NEW QUESTION 31
You need to create a combo chart to display the count of orders by month and profit by month as shown in the exhibit. (Click the Exhibit tab.)

How should you configure the combo chart? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 
Order Count:Stacked columnNo Profit:LineYes
http://www.excel-easy.com/examples/combination-chart.html

NEW QUESTION 34
You have a table named AnnualSales. A sample of the data in AnnualSales is shown in the following table.

You need to create a PivotTable as shown in the exhibit. (Click the Exhibit tab.)

How should you configure the Rows are and the Columns area in PivotTable Fields? To answer, drag the appropriate fields to the correct areas. Each field may be
used once, more than once, or not at all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.
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A. Mastered
B. Not Mastered

Answer: A

Explanation: 

NEW QUESTION 38
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer chokes, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You are creating reports for a car repair company. You have four datasets in Excel spreadsheets. Four workbook queries load the datasets to a data model. A
sample of the data is shown in the Data Sample exhibit.
Data Sample exhibit:

The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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The tables in the model contain the following data:
 DailyRepairs has a log of hours and revenue for each day, workshop, and repair type. Every day, a log entry is created for each workshop, even if no hours or

revenue are recorded for that day. Total Hours and Total Revenue column.
 Workshops have a list of all the workshops and the current and previous workshop managers. The format of the Workshop Manager column is always

Firstname Lastname. A value of 1 in the IsLatest column indicates that the workshop manager listed in the record is the current workshop manager.
 RepairTypes has a list of all the repair types
 Dates has a list of dates from 2015 to 2018

End of repeated scenario.
When you attempt to create a relationship between DailyRepairs and Workshops, Power Pivot generates the following error message: “The relationship cannot be
created because each column contains duplicate values. Select at least one column that contains only unique values”.
You need to ensure that you can create a valid relationship between the tables. What should you do?

A. In the Power Pivot model, change the data type for Workshop[ID] to General
B. In the workbook query for Workshops, add an index column
C. In the Power Pivot model, change the Table Behavior setting for Workshops
D. In the workbook query for Workshops, filter [IsLatest] to equal 1

Answer: C

Explanation: 
References: https://msdn.microsoft.com/en-us/library/hh560544(v=sql.110).aspx

NEW QUESTION 41
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have two Microsoft SQL Server database servers named Production1 and Test1. Production1 contains the same tables as Test1. but only a subset of the
data.
You add Test1 as a data source, and you select 10 tables. You configure several transformations. You need to connect the model to the tables in Production1. The
solution must maintain the existing
transformations.
Solution You create a new connection to Production1, and then you import the tables. Does this meet the goal?

A. yes
B. No

Answer: B

NEW QUESTION 43
You create a new workbook and add a table to a data model. The data is shown in the following table.

You need to create a visualization as shown in the following exhibit.

Which three actions should you perform in sequence? To answer, move the appropriate actions from the list of actions to the answer area and arrange them in the
correct order.

A. Mastered
B. Not Mastered

Answer: A
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Explanation: 
 Create a Pivot Table. Create a measure.
Create a Power View Report

NEW QUESTION 47
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario.
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The tables are loaded to the data model, but the data is not
loaded to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
Exhibit:

Your company has 100 product subcategories and more than 10,000 products. End of repeated scenario.
You plan to use the DAX time intelligence functions of DATEADD and DATESMTD. You need to ensure that the functions return the correct data.
What should you do first?

A. Delete and recreate the relationship between FactSales and DimDate.
B. Change the Data Type of FactSales[DateKey].
C. Mark DimDate as the date table.
D. Change trie Data Type of DimDate[DateKey].

Answer: C

Explanation: 
https://docs.microsoft.com/en-us/sql/analysis-services/lesson-3-mark-as-date-table?view=sql-analysis-services-2

NEW QUESTION 51
Note: This question is part of a series of questions that use the same scenario. For your convenience, the scenario is repeated in each question. Each question
presents a different goal and answer choices, but the text of the scenario is the same in each question in this series.
Start of repeated scenario
You have six workbook queries that each extracts a table from a Microsoft Azure SQL database. The table are loaded to the data model, but the data is not loaded
to any worksheets. The data model is shown in the Data Model exhibit. (Click the Exhibit button.)
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Your company has 100 products subcategories and more than 10,000 products. End of repeated scenario.
You need to create a chart as shown in the following exhibit.

Which field should you use for each area? To answer, drag the appropriate field to the correct areas. Each field may be used once, more than once, or not at all.
You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Axis: Month Year Legend: Channel Name Values: SalesAmount

NEW QUESTION 52
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You have the following table named SalesOrder Detail in a model.

You need to calculate the sum of SalesTotal for all the rows that have a quantity greater than 1.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
CALCULATE(SUMX(‘SalesOrdersDetail’[SalesTotal]),‘SalesOrderDetail’[Quantity] > 1)

NEW QUESTION 57
You have a query that retrieves the following data.

You need to configure the query to ensure that the data appears as shown in the following table.

What should you do?

A. From the Transform tab, use the sum function on the Vendor_ID column
B. Group by Vendor_ID and add a SUM aggregation
C. Unpivot the table on the Vendor_ID column
D. Pivot the table on the Vendor_ID column

Answer: B

NEW QUESTION 59
You have a PivotChart template named Template1. You add a PivotChart to a worksheet.
You need to apply the template to the PivotChart. What should you do?

A. On the Design tab, click Change Chart Type.
B. On the Format tab, click Format Selection.
C. Right-click the chart and then click PivotChart Options.
D. Right-click the chart and then click Format Chart Area.

Answer: A

Explanation: 
 Click the chart
 On the Charts tab, under Change Chart Type, click Other, and then under Templates, click the chart template that you created.

https://stackoverflow.com/questions/17386777/how-to-apply-a-saved-chart-template-to-an-existing-chart
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NEW QUESTION 64
You have a date column named [Date] in the format of mm-dd-yyyy.
You need to create a column named Quarter that displays the yearly quarter. A sample of the desired data is shown in the following table.

How should you complete the DAX formula? To answer, select the appropriate options in the answer area. NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
MONTH3
="Qtr " & ROUNDUP(MONTH([Date])/3,0)
="Qtr " & ROUNDUP(MONTH([Date])/3,0)
http://www.decisivedata.net/blog/quickly-create-week-month-quarter-and-year-fields-from-a-date-using-dax

NEW QUESTION 69
You merge several CSV files by using Query Editor.
You need to remove all the leading whitespaces and all the non-printable characters from a column.
What should you do to achieve each task? To answer, drag the appropriate actions to the correct goals. Each action may be used once, more than once, or not at
all. You may need to drag the split bar between panes or scroll to view content.
NOTE: Each correct selection is worth one point.

A. Mastered
B. Not Mastered

Answer: A

Explanation: 
Box 1: From the Extract menu, click Trim Box 2: From the Extract menu, click Clean

NEW QUESTION 74
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result these questions will not appear in the review screen.
You have the following data.

You need to retrieve a list of the unique ProductName entries.
Select the ProductName column, and then click Group on the Data tab. Does this meet the goal?
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A. Yes
B. No

Answer: B

NEW QUESTION 79
You have an Excel workbook that has the following two workbook queries:
* A query named Consultants that retrieves a table named Consultants_Contact from a Microsoft SQL Server database
* A query named Employees that retrieves a table named Employee_Contact from a Microsoft Azure SQL database
Both tables have the same columns.
You need to combine all the data from Consultants and Employees into one table. Which command should you use?

A. Transpose
B. Merge Queries
C. Combine Binaries
D. Append Queries

Answer: D

Explanation: 
Append is similar to UNION ALL in T-SQL.
Append Queries will NOT remove duplicates. You have to use Group By or Remove Duplicate Rows to get rid of duplicates.
Merge is similar to JOIN in T-SQL
http://radacad.com/append-vs-merge-in-power-bi-and-power-query

NEW QUESTION 84
Note: This question is part of a series of questions that present the same scenario. Each question in the series contains a unique solution that might meet the
stated goals. Some question sets might have more than one correct solution, while others might not have a correct solution.
After you answer a question in this section, you will NOT be able to return to it. As a result, these questions will not appear in the review screen.
You have a Power Pivot model that contains the following tables.

There is a relationship between Products and ProductCategory.
You need to create a hierarchy in Products that contains ProductCategoryName and ProductName.
Solution: You create a measure that uses the ISCROSSFILTERED DAX function Does this meet the goal?

A. Yes
B. No

Answer: B

NEW QUESTION 86
......
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